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Introduction
Annotating PDFs ensures that your corrections are absolutely clear and that errors cannot be
introduced through misinterpretation of your markup. This guide is intended to show you the
essential tools you need to start using eAnnotation but if you need further information please refer
to the Adobe Help files.
To start using eAnnotation make sure you have downloaded the most recent version of Acrobat
Reader from www.adobe.com. This will give you access to the widest range of annotation tools
and ensure that you are able to work with the files that we send to you. This document is written
with Adobe Reader X screen shots.
Please note:
•

The proof will have been edited to house style. We retain the right to veto amendments if they
are non-essential or too costly.

•

Do not edit the PDF files even if you have the means to do so. All changes must be visible.
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Viewing your documents

Viewing two page spreads
You may wish to view your document in a two page format to see the layout as it would be in print.
In the View menu, select Page Di
Display,
play then either Two Page View to see only two full pages at a
time, or Two Page Scrolling,
Scrolling to allow scrolling through the document, in a two-page format.

Note: If, when viewing the proof in a two page format, what should be a left hand page (verso)
appears on a right hand page (recto) and vice versa, you can correct this by clicking on Show Cover
Page in Two Page View in the same menu (see above). You should aim to have even-numbered
pages on the left hand page and odd-numbered pages on the right.

Comparing documents
You may wish to have two documents open together for comparison, for example, if you are
collating your contributors’ comments onto one set of PDFs.
In the Window menu select Tile and then Horizontally or Vertically.
Vertically
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Adjust both document windows/frames to maximize screen space by drawing your cursor over the
edge of the documents until it changes into a double-sided arrow. Holding the left mouse button
down you can resize the document frame by moving your cursor.

Horizontal Tiling:

Vertical Tiling:

Accessing the Comments Tools
The selection of tools you can use to annotate the proof is not visible by default when you open
Adobe Reader. Click on the Comment box in the top right corner of the page.

This opens up a panel down the right hand side of the page, made up of three sections. More
information on each of these three sections will follow.
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In addition you may need to change a preference setting in order to use the editing tools. In the Edit
Edit
menu, click on Preferences,
Preferences select the Documents tab in the left menu and change PDF/A View mode
to Never.
Preferences’
Never. (Note that for the Mac version of Adobe Reader X, ‘Preferences
Preferences can be found in the main
Adobe Reader menu.)

If you have done both of these actions and you still cannot annotate your proofs then please let your
contact person know and they will resupply the PDFs.

Annotations Tools
When marking corrections to your proofs, the majority of tools you will use will be found in the
Annotations section. From here you can highlight text, mark for text to be inserted, mark for
existing text to be replaced with new text, mark text for deletion, underline text, and attach a
comment balloon to a specific word or phrase.
Highlight text
Attach file
Sticky note

Delete text
Insert text
Add a comment
balloon about text

Replace text
Underline text
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Highlight selected text
Use the cursor to select the text to be highlighted, then click on the Highlight text
text icon in the
Annotations section. The characters you had selected are highlighted in yellow. This tool can be
useful when you are selecting terms for when you are compiling your index.

If you also need to use text edit tools on a highlighted word (e.g. to correct a spelling mistake) you
can do so. Simply go to the correct position using the arrow keys on your keyboard (you won’t be
able to select using the mouse once the text has been highlighted).
If you need to select text hold down the Shift key and use the arrow keys to select it.

Insert text at cursor
This allows you to insert a letter, word, or phrase to the current text. Place the cursor at the
insertion point, then click on the Insert text
text at cursor (Ins) icon in the Annotations section. A caret
mark appears in the text and a blue comments box opens for you to type the insertion.

You can type italic and bold text in the insertion box by pressing CTRL-I and CTRL-B (Note: for Macs
this is the ‘cmd’ key), and you close the box by clicking on the minimize symbol in the top right
corner. The caret mark remains visible to indicate that a change is to be made, and clicking on it
reopens the comment box.

Replace selected text
This allows you to replace one letter, word, or block of text. Use the cursor to select the text to be
replaced, then click on the Replace (Ins) icon in the Annotations section.
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Acrobat will score a line through the text to be replaced and insert a caret mark at the end. A
comment box opens into which you can type the text for insertion.

Here, the instruction is to replace ‘Figure 2’ in the proofs with ‘Table 3’ (typed in the blue comment
box). You can type italic text by pressing CTRL-I (the “Ctrl” and “I” keys on the keyboard
simultaneously) and bold text by pressing CTRL-B. To switch off italic/bold, press CTRL-I/CTRL-B
again. Close the comment box by clicking on the minimize symbol in the top right corner. The blue
line and the caret mark remain visible to indicate that a change is to be made, and clicking on either
reopens the comment box.

Cross out text for deletion
This allows you to delete a letter, word, or phrase in the current text. Use the cursor/mouse to select
the text to be deleted, then click on the Strikethrough (Del) icon in the Annotations section. A red
line is scored through the text.

Underline selected text
Please don’t use this tool for annotating PDFs. Although underlining is the conventional indication
for text to be set in italic type, we prefer that you use the Add notte
e tto
o ttex
ext tool to highlight this
ex
instead.

Add note to text
Use the cursor to select the text to be highlighted, then click on the Add note to text tool icon in the
Annotations section. This works in the same way as the Sticky note tool except that instead of
placing a balloon at the cursor, it highlights the selected text in yellow.
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It can be a useful way of asking us to check that a font is correct or telling us to change a word or
phrase to bold or italic.

Add sticky note
This tool allows you to attach an electronic Post-It note to the document. It should not be used for
editing. However, the note can be used for general comments rather than specific line corrections.
You might, for example, want to ask a co-author to review a passage for sense or ask us to make a
global change (e.g. from ‘decision making’ to ‘decision-making’).
Click on the Add sticky
sticky note icon in the Annotations section, then click on the text or margins where
you wish your comment to appear. A small balloon icon will be placed at the cursor, linked to a box
into which you can type your comments:

Type your comment and then click on the minimize symbol in the top right corner. The balloon icon
will remain visible, and you can open (and edit) the note by double clicking on this icon.
If you are responsible for collating comments from contributors, co-editors or co-authors then you
will find the ‘Options’ button, in the top left corner of the box, useful for replying to comments or
for deleting, accepting, or rejecting comments. You can also change the shape of the balloon to
represent different types of comment. Please note: any comment intended for someone other than
the publisher or our freelance suppliers (i.e. Project Managers, Proofreaders etc.) must be removed
before the file is returned to us.

Inserting special characters
In general, if a special character has a keyboard shortcut in Word, this will also work in a note box
(e.g. type ALT-0150 for an n-dash or ALT-0151 for an m-dash. If you don’t know the shortcut or
there isn’t one, type the special character in Word and copy and paste it into the note box. (Note: for
Macs, use the ‘cmd’ key instead of ‘ALT’. Shortcuts may be different to those on a PC).
Alternatively, for more complex special characters, it may be better to attach a file with the character
showing correctly (see below for instructions on how to do this).
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Attaching documents
It’s possible to attach accompanying files to your annotated PDF. These files may be replacement
figures, large sections of text to be inserted, or text including more complex special characters.
Click on the Attach file
file icon in the Annotations section, then click in the text or the margin close to
the point to which the file relates.
A pop up box will appear, from where you can select the file to be attached . Click open once you
have the file selected, then confirm the properties for the attached file (in particular how you want
the attachment marker to appear in the proof).

Click OK and the icon for the attachment appears in the proof.

Drawing markups tools
The next section in the Comment panel is the Drawing Markups
section. The drawing tools in this section can be useful for
highlighting sections of the text, tables, or figures that are to be
moved and highlighting where they are to be moved to. You can
draw lines, ellipses, rectangles, cloud shapes, or free-form
shapes from this section.

Comments List
Expanding the Comments List gives you a view of all amendments and comments marked up in the
proof. Clicking on each item in the Comments List highlights the corresponding markup in the text.
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Sort comments into order by
different characteristics
Search box
Filter the comments list to
show only certain types of
comments/amendments

The identity of the
person who made the
correction

Options

Check box: useful for checking

This icon shows the type
of correction made

revised proofs against marked
up first proofs

Details of the correction

Check boxes
When checking revised proofs against the corrected first proof (for Project Managers, Proofreaders,
and Production Editors), you may find it useful to tick off corrections as you check that they have
been made. Selecting an item in the Comments List brings up an empty check box in the top right
hand corner. Click on this to tick the box and again to untick it. Ticked boxes stay marked when you
click on a new item in the list.

Changing the identity to whom amendments are attributed
(e.g. to differentiate between corrections made by different people or to keep comments anonymous).

If you wish to change the identity marked in the annotations, it’s best to do this before you start
marking changes, as changing it in all items in the Comments List after amendments have been
made can be time consuming. This can be done as follows:

1. Mark up the first amendment as usual. Be sure to make an
amendment that creates a box into which text can be entered
(i.e. Add sticky note, Insert text, Replace text, Add note to
text, etc.)

2. Right click in the top section of the box (where the date, time,
and author of the correction are included) and select Properties in the
menu that appears.
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3. On the General tab of the box that appears, you’ll find the
author name. Change this to the name of the person
making corrections. If the person marking up corrections
wishes to remain anonymous, they can either type
‘anonymous’ or else delete the author name completely.
Click OK once done.

4. Note that this only changes the author name in the box
first clicked on. To apply the author name change to all
notes/comments boxes (going forward, not retrospectively,
i.e. this will not change the author name in notes/comments
that have already been created), right click the date, time, and
author name section of the box for which you have just
changed the author name. In the menu that appears click on
MakeCurrentPropertiesDefault.

You have now changed the author name for all subsequent comments/notes boxes. To change the
author name in comments/note boxes that have already been created follow steps 1–3 above for
each individual note/comment.
Remember to save your changes when you close the document.

Printing
In Adobe Reader X it is possible to
print out marked up comments at the
same time as printing the document.
To do this, click the print icon on the
top toolbar (or else, in the File menu
click Print),
Print
In the Comments and Forms section
of the box that appears, select
Document and Markups and, at the
bottom of the page, click on the
Summarize Comments button. Once
all other details are correct click OK to
print.
Page | 10

Troubleshooting
If someone has annotated a PDF using the
full version of Acrobat, it is easy for them to
save the document in such a way that it
disables the comment tools for use in
Reader. If you receive a PDF where this has
happened, an error message will pop up to
say that “the document has been changed
and the rights to enable special features in
Adobe Reader are no longer valid”.

In this case, the person who sent you the PDF needs to go back into the file in the full version of
Acrobat, click on the Comments menu, and then select Enable for Commenting and Analysis in
Adobe Reader.
Reader If they then save the file and resend it to you, you should be able to annotate the
PDFs as normal.
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Guidelines - Making Changes in a PDF Using Adobe tools

1. Introduction
Adobe Reader is the standard tool used for electronic document sharing. It is the
only PDF file viewer that can open and interact with all PDF documents. In order to
utilize its functional properties Wiley’s page proofs are ‘Comment Enabled’, a
feature that allows you to make comments in the PDF documents using Adobe
Reader. You can download Adobe Reader at www.adobe.com. Please note these
screen shots have been taken from a Windows machine. There may be slight
differences for a Mac.

2. Procedure
The PDF will come to you with commenting enabled. If you come across any
problems with commenting you can check whether the comment enabling has
worked by right clicking the PDF to find 2 options. Option 1: click the Tools option
and scroll down to "Comment & Markup" (Figure A) and see if the available options
shown below appear; option 2: right click the PDF to find "Add Sticky Note" as the
first option. If either of these options works then the PDF is comment enabled.
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3. Options in Adobe Reader
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4. Role of Icons in Comment and Mark up tool
I. Sticky Note tool (

)

This tool enables adding instructions and corrections in the file. Select the icon and your
cursor will change to the sticky note icon. Click where the change is to be done. A sticky note
pane will open into which you can key your comment or correction.

II. Text Edit tool and its options
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5. Options available in text edit tool bar
These screen shots reveal the available options and their usages. Textual changes could
be carried out using the Text Edit Tool.
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